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Lesson 1: Getting Started  

Lesson Objectives 
In this lesson, you will look at how to configure or personalize OneNote, including the working environment, 
pages, and notebooks. You will also look at how to create and save a notebook in various locations. On 
successful completion of this lesson, you will be comfortable with: 

 identifying screen elements 

 customizing the working environment 

 customizing the page setup 

 setting properties  

 creating a new OneNote notebook  

 recognizing various page layout options 

 using containers 

 working with simple lists 

 opening or closing notebooks 

Introducing OneNote 
Microsoft OneNote is an application within the Microsoft Office 2013 suite of programs that enables you to 
gather information in the form of notes from a variety of sources in an undefined manner, and then organize 
these into pages or sections. This is similar to gathering pages of hard copy notes and diagrams and adding 
them to a binder, using dividers to separate the information. 

In OneNote, the notes can be handwritten or typed, and can contain pictures or drawings as well as audio or 
media files. You can then share this information with others and collaborate on a project using the OneNote 
notebook to store everyone’s contributions. 
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The difference between using OneNote and a program such as Word to capture your notes is that the 
information you gather for OneNote usually is not structured for publication in the same manner as a Word 
document. You may eventually turn your notes from the OneNote notebook into a published document, but 
at the time you are working in OneNote, it is simply a central location to deposit related information on a 
topic. 

Common uses for OneNote include: 

• a journal to keep notes on a trip (including items such as photos, contacts, itinerary) 

• a schedule of things to do, which link to additional pages where you can get information on these tasks 
(such as church, reception rentals, florists, pictures of favorite wedding dresses along with local wedding 
dress retailers, or contact information for printers) 

• a research project (such as Web sites with historical information, contact information such as libraries or 
people, or contributions from other people involved in the research project) 

• a place to keep notes from meetings, lectures, studying, or exam preparation. 

As you begin using OneNote, you will find there are many ways you can use it to help you keep organized, 
or to simply gather information for a particular task. 

Looking at the Screen 
An example of a typical OneNote page is shown: 

 

File Tab Click to display Backstage view, from which you can select commands for a file (for 
example, New, Open, Save). A panel at the left displays commands that may include tabs 
with a set of sub-commands you can use to manage the file. 

Page Tabs 

Section Tabs Navigation Tab 

Page Title 

Page Content 

Search Field 

Ribbon 

Quick Access Toolbar 
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Quick Access 
Toolbar 

Gain quick access to frequently used commands. You can customize the toolbar, which 
is located above the ribbon, to contain commands you use regularly. 

Title Bar View the name of the page currently displayed on the screen (for example, Untitled page 
– Microsoft OneNote, University Courses – Microsoft OneNote) on the title bar, located 
at the top of the screen. 

Ribbon Display 
Options  

Minimize the ribbon to display more of the notebook contents, display only the ribbon 
Tabs, or display the full ribbon. 

Help Display the Help window to obtain the latest help on a feature; Microsoft’s Help option 
links to the Microsoft web site for the latest information. You can also use the help topics 
installed with Office. 

Ribbon Gain quick access to commands through this collection of tabs (for example, File, Home, 
Insert, Share). 

Ribbon Tab Gain access to commands grouped on tabs for specific purposes, such as editing, 
inserting objects, viewing options, or page layout. 

Ribbon Group Gain access from within tabs, each of which contains a group of related commands for 
editing, formatting, or enhancing items in your notebook.  

Navigation 
Tab/Pane 

View available notebooks on the panel or tab at the left side of the screen. The preceding 
screen capture shows the Navigation pane collapsed as a tab for the current notebook; 
when expanded, the bar displays other open notebooks as well as an option to create 
Quick Notes. Use the tab to expand or collapse the pane. 

Section Tabs Display the name of each section in colored tabs to indicate the different content for 
that page; the preceding screen capture shows Project Management, Design Notes, and 
so on as an example, but you can rename these tabs to match your content. Use the 

 tab to create a new section tab. 

Search Field Use this field to search for content on individual pages, in sections, or in notebooks. 

Page Tabs Create new pages or subpages. The preceding screen capture shows the Page Tabs bar 
expanded and displaying pages called Schedule, Milestones, and so on. Use the  or 

 button to add more pages. 

Page Title The name or title of the page; whenever you create a new page, the text entered here 
becomes the name of the page. You can also rename or hide the title, as needed. 

Page Content Display all your notes, pictures, and links in this area.  Enter the Page Title in the box at 
the top of the page; it then automatically appears in the Page Tabs area to the right. 

Quick Notes  Click this at the bottom of the Navigation Tab to create notes that may not be related 
to the notebook you are currently using. For instance, you may be taking notes at a 
lecture and suddenly remember the Web address that a contact gave you earlier in the 
day for another project you are researching. Use this button to create a new page where 
you can enter the information quickly, and then later, file with its appropriate notebook. 

The previous screen displays commonly used areas of the OneNote screen. However, as you can customize 
the screen’s appearance, additional items may appear on your screen that are not discussed here. We will 
look at how to change or reset preferences for the working environment or notebook shortly. 
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Using the Quick Access Toolbar 
The Quick Access Toolbar, at the left of the title bar above the ribbon, includes buttons for frequently used 
commands. By default, this toolbar contains the following icons: 

 
Use the last button to customize the toolbar to display those commands you use frequently, such as print 
preview, forward, or a favorite pen. 

To customize the Quick Access Toolbar, use one of the following methods: 

• Click Customize Quick Access Toolbar, and then click a button from the 
displayed list or click More Commands; or 

• click File, click Options, and then click Quick Access Toolbar; or 

• right-click anywhere on the ribbon, click Customize Quick Access 
Toolbar, and click a button from the list or click More Commands. 

To move the Quick Access Toolbar to below the ribbon: 

• Click Customize Quick Access Toolbar and then click Show Below the 
Ribbon; or 

• right-click the ribbon and then click Show Quick Access Toolbar Below 
the Ribbon. 

Using the Ribbon 
The ribbon can help you find commands quickly. Commands are grouped on tabs with each tab relating to 
a type of activity, such as inserting items, changing the view, or formatting text. You can customize the ribbon 
to display commands you use frequently in a particular order, or to add or remove commands for a ribbon 
tab. 

 
To reduce screen clutter, contextual tabs, such as Table Tools, appear only when they are applicable. 

 
  

Undo 

Back Customize Quick 
  Access Toolbar 
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A button that appears in a different color or has an outline is active; many of these de-activate when you 
click the same button again or click another choice. For instance, you can apply the Bold command to 
selected text by clicking that button and then turn off the boldface by clicking the same button again. 

When the feature displays an arrow, as with the Font or Size feature, the active item appears in the list and 
you can click the arrow to display the full list for selection. In most cases, you will be able to change the 
selection for the feature by clicking the same arrow and then clicking another item from the list. For instance, 
if you want the text to be a different size, click the arrow for the Size button and choose the required size. 
When you need to change the font size again, click the arrow for Size and then select the new size. 

  
Each tab on the ribbon contains groups with similar commands; for example, the Home tab includes a group 
called Basic Text that contains buttons for formatting text characters while the Insert tab includes a groups 
with different types of items that can be inserted into a note page. 

If a group of commands is accompanied by a scroll bar, you can click on a button below 
the bottom scroll button, called the More button, to display the full list of options for 
that command. This is shown in this illustration.  

When clicked, the More button displays a gallery with additional options, as shown in the illustration to the 
right. The currently selected option (in this illustration, Normal) is highlighted with a box around it; to apply 
any other selection, simply click it. 
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Occasionally when you select a feature, it will open a dialog box or a task pane offering further selections, as 
shown in the following illustrations. 

  
 Dialog Box Task Pane 

With a dialog box, you can type in an entry (such as a measurement), select an item from a list, use the arrow 
with a list box to display more choices for that list, or click a command to turn the feature on or off. A dialog 
box may also display a preview of the changes to guide your choices. 

A task pane, on the other hand, usually offers options specific to a feature. This is shown in the preceding 
graphic, which includes fields you can use to find specific research information. Another task pane is the 
Customize Numbering pane, which displays a list of formats you can use to number your text list. 

You can collapse the ribbon if you want to show more of your document or you do not want to display the 
ribbon. To collapse the ribbon: 

• Click the  button at the far right of the top of the ribbon; or 

• double-click any of the ribbon tabs; or 

• right-click anywhere on the ribbon and then click Collapse the Ribbon; or 

• press + . 

To display the ribbon again, use the  button or any of the previous methods. 

You can also access the ribbon using the keyboard; some users consider the keyboard a faster method for 
accessing commands. Many keyboard shortcuts, such as +  to copy, +  to save, and +  
to print, are the same throughout Windows programs, making it easy to remember what to do from one 
program to another. 

To access the ribbon using the keyboard, press  or ; this will display the keyboard buttons for the 
commands in the ribbon. 
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When you press the key for the appropriate feature, OneNote displays the next set of keys you can use to 
select a command or feature. For example, pressing  displays the Home tab. 

 
You can then press the appropriate key to access that feature. 

You can also use the keyboard to: 

• Access another tab; with the ribbon active, press  or  to move to the appropriate tab. 

• Change the highlight or focus from the active tab to the search field; simply press .  

• Display a shortcut menu for the selected command; press + . 

• To move from the tab to the command in the first group; press . Continue pressing  to move 
to the next command, or +  to move to the previous command. (You can only do this if you’ve 
pressed   or  to display the keyboard shortcuts on the ribbon.) 

• Activate the selected command; press . 

• Exit or cancel a selection at any time; press . (You may need to press  more than once to return 
to your page.) 

Managing OneNote Notebooks 
Files created for OneNote are considered notebooks, similar to traditional paper notebooks that you may 
have used to keep track of notes, ideas, pictures, and so on. Notebooks can consist of: 

• individual pages 

• sections that may contain pages and subpages 

• section groups that may contain sections, pages, and subpages. 

You can view and work on only one notebook at a time; you cannot have multiple sessions of OneNote open 
as you can with other Office programs. 

You will use Backstage whenever you need to manage your notebooks. It is in this area where you will 
configure how and where the notebooks are saved, as well as default options you want all notebooks to 
share such as the font, rule lines, or view. 

Personalizing OneNote 
Objective 1.4 

When you start OneNote the screen appears with default settings for the working environment which you 
can change to suit your preferences. These can be found by clicking the File tab and then clicking Options. 
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